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SCAT is a game of chance and skill.    It is fun, challenging, and addictive. 

For a description of how to play this game and on how to use the commands available to 
you in SCAT, click on the underlined topic below.
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What is Scat?
SCAT is a card game for four players, played with 52 cards.    Players 1, 2 and 3 are played 
automatically by the program.    Player 4, which represents you, may be played either by 
yourself (the Human Player) or by the program.

A hand with a total value of 31 points (an Ace and two other cards worth 10 points each) is 
called SCAT.

Objective

The program deals each player 3 cards. The objective is to obtain a final hand that is all of 
the same suit and whose value is not the lowest among the four players.    The player with 
the lowest card hand loses that hand.

Features

SCAT allows you to:
Define one of three strategies for each of the four players to follow.
Identify each player by assigning them a name.
Show player comments during the game.
Set the speed at which the cards are dealt and discarded.
Leave the cards face up or face down during the game.
Vary the location of the player icons on the screen from game to game.
Decide which card back design to use.



How to Set Game Options
Before you start a game, you may want to select Game Setup from the menu bar to 
determine the strategy and game setup options you want to use.    The following dialog box 
displays.

If you do not specify values in the Game Setup dialog box, the program uses the values last 
saved.    

Player Name

Identify each of the four players with a name.    While SCAT allows you to enter an unlimited 
number of characters and/or numbers in the Player 1, Player 2, Player 3 and Player 4 boxes, 
the program will only display up to 11 characters in the player icons.

The four names you define will be used throughout the entire game.    If you change a name
in the Game Setup dialog box any time after the game has started, the new name will not 
be applied.    

Player Strategy

You may define a strategy for each of the four computer players to follow. If Player 4 is 
being played by you and not the computer, (Human Player selected from the Options 
menu), the strategy selected for Player 4 will not apply.

Choose from three strategies:
Conservative - The player using this strategy determines what suit to follow early on 

in the game and does not deviate from that suit when deciding on what cards to pick up and
discard.

Gambler - The player using this strategy will constantly change suits to improve their 
hand by looking for high cards.

Acer - The player using this strategy is basically a Conservative player who will 
always pick up an Ace card, if it has a marginal chance of improving their hand.

You can not change strategies during a game.
 
Game Speed



Use this box to set the speed at which cards are dealt and discarded. You may select a 
value ranging from 1 to 10, 1 being very slow and 10 being very fast.    Use 5 for a 
moderate, comfortable speed at which to play.    You may change the speed at any time 
during the game.

Place Players Randomly

Select this checkbox before you start the game to indicate that you want the four player 
icons placed in any order on the screen from one game to the next.    If this box is not 
selected, the four player icons will always be found in the same location.

Show Player Comments

Select this checkbox at any time to indicate that you want the comments of each player to 
be revealed in the player icons. If this box is not selected, the player icons will be blank and
the players' comments will not display. 



File Menu

Start Game

Select this command to set up and begin a new game.

End Game

Select this command to end a game that is currently in progress.    You may then either start 
a new game or exit SCAT.

Exit

Select this command to exit the program.    When you exit SCAT, all of the game setup 
values and options are retained and used as the defaults for the next game.



Options Menu

Play Cards Up

This command only applies to those players controlled by the program.    The hand played by
the Human player is always shown.

Select this command at any time to show everyone's hands while playing the game. If a 
checkmark appears next to this command, all of the cards in each player's hands will be 
turned up.    If a checkmark does not appear next to this command, the cards of your 
opponents will be hidden from your view, as in an actual game.

Card Backs

Select this command at any time to set the design for the backs of the cards.    You may 
choose from 8 designs.    

Human Player

Select this command at any time to indicate that you want Player 4 to be represented and 
played by you instead of the computer.    If a checkmark appears next to this command, 
Player 4, the Human Player, is under your control.    If a checkmark does not appear next to 
this command, Player 4, like the other three players in the game, will be played 
automatically by the computer.    



Other Products from Bob Dolan Software
DeskMenu --    A slimmed down Program Manager for Windows
Version 1.30 - November 1993

An efficient replacement or addition to the Program Manager.    Provides a menubar at the 
top of the Windows desktop with menu headings defined by you to represent the categories
of applications you typically need to access.    A simple interface allows you to customize 
the look and feel of this useful system utility.

Shareware.........$10

WinGo! --    The classic Bingo for Windows
Version 1.20 - October 1993

Finally Bingo has arrived for Windows!    You match wits with Rosie, an alert and cunning 
adversary.    You can play with as many cards as you can handle at the speed you like.    
Fully configurable to adapt to your playing style.    The registered version includes digitized 
voice calling for the most realistic Bingo play possible.

Shareware.........$10

WinDial -- A    Windows Phone Book that dials
Version 1.0 - May 1993

An easy to use phone book that will automatically dial any selected number as long as you 
have a modem.    When a busy signal is detected, you can tell WinDial to retry until 
someone answers.    Other busy attempts can be placed into a queue, and all will be retried 
in order.

Shareware.........$10

Mister Clean -- Clean up your hard drive
Version 2.00 -- December 1993

One of the most efficient ways to clean up those hidden but unwanted or unused files that 
take up needed space.    A slick Windows 3.x user interface makes this utility a must have 
for your toolbox.    Mister Clean finds the files you specify and sorts them by size.    You click 
on the ones you want deleted and then off they go, one-by-one (to be safe) or all at once.    
Not sure what the file is?    Then run it right from Mister Clean and check it out before 
dumping it!    Truly a unique way of managing precious disk space.

Shareware.........$10

<softWAREhouse> -- A warehouse for all of your software
Version 1.10 -- November 1993

<softWAREhouse> provides your system with the ability to access more applications than it
can hold at one time.    This is made possible by storing installed applications offline until 
they are needed.    When required, they are put back on the user's machine in the same 
condition and location as they were when originally stored.    All of this power is surrounded 



by an easy to use point and shoot menu interface.

Shareware.........$15

Yacht-Z    --    A dice strategy game for Windows 3.X
Version 2.22 -- October 1993

Yacht-Z is a version of the classic dice game.    Now, in addition to triple scoring, single 
scoring is included for quicker, simpler games.    Due to popular request, up to four players 
can now play at one time.    A new look to all dialogs gives the program new life in the world
of Windows 3.1

Shareware.........$10

BattleGrid -- War in a window -- Battleship for Windows 3.x
Version 2.0 -- May, 1993

BattleGrid is a version of the classic board game.    Play against the computer or another 
person.    Watch the computer play against itself using different strategies.    Several levels 
of a computer opponent are available, from idiot to genius.    

Shareware.........$10

MagnaFile -- A DOS user interface 
Version 2.2 -- October 1992

MagnaFile is a DOS shell which is directed at a wide range of users from the DOS beginner 
to the most prolific DOS power users. MagnaFile provides services to the user to simplify 
access to DOS.    It also increases the efficiency of doing many of the more tedious 
operations DOS requires.

MagnaFile commands are carried out using a one-key interface.      Most operations are 
associated with a very obvious key, such as <C> for the Copy command.

The most useful utilities provided by MagnaFile are:

                For Single Files or Groups of Files:
                        Copying
                        Moving
                        Deleting.
                        Attributes
                        Printing

                File Descriptions (40 characters)
                File Viewing & Editing
                File execution
                Disk navigation
                File & Directory Renaming

                File Archiving, Unarchiving, and Archive viewing
                Command line interface
                Mouse handling



                Screen saver and password protection
                Run programs from a smart menu interface
                
MagnaFile is similar to Norton Commander(NC). Users of this product say that MagnaFile 
will be an important tool on your computer, no matter what level user you are.

Shareware..........$20

Smart Solitaire -- The Smart way to play Solitaire
Version 1.01 -- November 9, 1989

A text mode klondike solitaire card game which uses the mouse.    Features BOSS mode and
smart playing features, such as automatic card placement in obvious situations.    Very 
addicting and fun!

Shareware.........$10

SCAT -- A strategic and daring card game
Version 1.01 -- February 1994

Don't get stuck with the lowest hand!    SCAT is a card game involving four players that can 
be as simple or challenging as you want.    Features include defining strategy levels, setting 
the game speed, and leaving the cards face up or face down as you play.    This game even 
includes conversational chit chat between the players!    Very addicting and fun!

Shareware.........$10



How to Play the Game
Once you have defined the game options and setup, select Start Game from the File menu. 
Using a 52 card deck, the program deals 3 cards to each of the 4 players.    The remaining 
cards are placed face down in the draw pile, with the top card turned up and placed in the 
discard pile.

The game begins with any one of the four players.    For the computer players, the program 
determines which cards to pick up and discard based on the strategy you specified for 
them in the Game Setup dialog box.    If the Human Player option is not selected, the 
computer will play all four hands.    You may select this option at any time to simply sit back
and watch as the computer plays.    If you want to participate and play against the 
computer players, make sure the Human Player option is selected.      

If you are playing, you will be Player 4.    When it is your turn, you may select the top card 
from either the draw pile or discard pile.    Click on the card you want from either pile.    The 
program moves the card alongside your hand.    If you want to keep this card, select the 
card from your hand that you want replaced.    Click on the card and the program replaces 
the card you selected from your hand with the card you picked up. If you do not want to 
keep this card, click on the card you picked up and the computer will return it to the pile.

As you pick up and discard cards, decide upon and follow a particular suit.    The computer 
continuously evaluates your hand and records your highest card values.    In SCAT, an Ace is
worth 11 points, the 10, Jack, Queen, and King are worth 10 points each, and all other cards
are scored at face value. The program will only add card values that belong to the same 
suit.    For instance, if you have a King of diamonds, a 4 of diamonds, and a 10 of hearts, the
program will record the value of your hand at 14 points (the King and 4 of diamonds added 
together).    If you have a King of diamonds, a King of clubs, and an Ace of hearts, for 
example, the program will take your highest card value, the Ace of hearts, and record that 
your hand is worth 11 points. A hand with a total value of 31(an Ace and two other cards 
worth 10 points each) is called SCAT.    However, in order to win at SCAT,all you need to do 
is make sure your hand is not the lowest.    

As you pay attention to the value of your hand, you will determine a strategy to follow.    
You can deviate from a conservative strategy to take risks in the game. To make the game 
less challenging, you could select the Play Cards Up option, which allows you to see all of 
the hands being played in the game.    By seeing the other players' hands, you can see if 
your hand is higher or lower than the other three players, and can quickly determine 
whether you can afford to take risks or need to stay with the same suit.

To indicate to the other players that you have reached a score of at least 21 and believe 
your hand not to be the lowest, you "knock".    When the Human Player option is selected, 
the knock button on the Player 4 icon is visible.    The knock button becomes enabled when 
you reach a hand that is worth 21 points or more.
Select the Knock button when you believe your hand is higher than one or all of the other 
players.    The higher your score, the better chance you have of not losing.    

When a player knocks, the program allows all of the other players to have one more turn 
and a chance to improve their hand.    The players then compare hands.    The player with 



the lowest score loses one coin.    When a player is out of coins, they are removed from the 
game. The players continue to play until all but one player remains. That player is the 
winner.



How to Keep Score
A SCAT game consists of playing several hands.    At the end of each hand, the program 
calculates the total value of each players' cards.    The player with the lowest value loses 
that hand.    

At the beginning of the game, each player starts out with four coins.    When a player loses 
a hand, they lose one of the four gold coins.    When a player loses all four coins, they are 
eliminated from the game.



How to Use Strategies
You can basically follow the same type of strategies available to the computer players in 
SCAT: Conservative, Gambler, and Acer.    The only difference is that you, Player 4, can 
change your strategy at any time during the game.    The computer players cannot.

If you want to play conservatively and not take any chances, stay with the suit you selected
from early on in the game.    You should always look for and select the highest card values 
in that suit.

If you want to take some risks and consider other opportunities, take a high card presented 
to you over a card in the same suit.    You may want to do this if the three cards in your 
hand, while all of the same suit, don't add up to the value of the high card.

If you want to really take some chances, you can follow a strategy to always pick up the 
Ace card every time it is available.

In SCAT, you may find that you should follow all of these strategies at different times 
throughout a hand.



How to Register
SCAT is distributed as shareware.    This means that if you regularly use the product and 
benefit from it, you should register with the author (see name and address below).    The 
software you now have is not crippled in any way.    This indicates a basic trust of the 
shareware concept by myself and other shareware authors who provide useful products 
with the hope of some type of return for their efforts.    Basic registration is $10.

Please print the registration form and fill in the requested information

You may reach me on GEnie at the following EMail address: DOLAN

Distribution

If you distribute SCAT to friends, associates, or to a computer bulletin board system (BBS),   
you may only distribute the compressed file including the copyright and disclaimer.

Disclaimer

The Copyright Owner hereby disclaims all warranties relating to this software, whether 
express or implied, including without limitation any implied warranties of merchantability or
fitness for a particular purpose. The Copyright Owner will not be liable for any special, 
incidental, consequential, indirect or similar damages due to loss of data or any other 
reason, even if The Copyright owner or an agent of The Copyright Owner has been advised 
of the possibility of such damages.    In no event shall The Copyright Owner's liability for 
any damages ever exceed the price paid for the license to use the software, regardless of 
the form of the claim.    The person using the software bears all risk as to the quality and 
performance of the software.



How to Change the Card Back Design
Select Card Backs from the Options menu.    A Select Card Back Style dialog box displays.

Click once on the card design you want and select the OK button. If you decide not to 
change the design and to use the selection last specified, select the Cancel button.



Registration Form
To print this registration form, open the File menu and select Print Topic.

Mail to:

Bob Dolan
P.O. Box 16514
Rochester, New York USA 14616-0514

Please register me as a satisfied user of SCAT    (ver 1.01):

Amount Enclosed: 
                                  $10 [    ]    Registration No disk included      

                                  $15 [    ]    Register w/upgrade. [    ]3.5      [    ]5.25

A $15 registration entitles you to receive a free registered copy of WinDial.    This 
exciting utility provides you with a complete database to store all of the names 
of anyone you contact by phone, along with a memo for each entry.    It's easy to 
use, and if you have a modem, will automatically dial anyone in your database 
for you.    WinDial will even retry busy numbers as often as you specify until they 
answer.

For orders from outside of the U.S., please add $3 to cover 
additional postage.

Can you UNZIP files?    Yes________    No________

Name:_____________________________________________________

Address:___________________________________________________

City:______________________State:_______Zip:__________________

Phone(optional):_____________________________________________

GEnie/CompuServe/Internet mail 
address:_______________________

Where did you get SCAT?___________________________

___________________________________________________________

Comments:_________________________________________________

___________________________________________________________

___________________________________________________________

___________________________________________________________



___________________________________________________________



There are four square boxes, or player icons, shown on the screen.    Each icon represents a 
player in the game.    A player icon displays the name of the player and four gold coins for 
keeping score.    If Show Player Comments is selected from the Game Setup menu, the icon 
also displays the player's comments about the game.



If Human Player is selected from the Options menu, Player 4 represents you (the human 
player). The remaining three players are played by the computer. If this option is not 
selected, all of the players in the game are controlled by the program. 



The discard pile, located to the right of the draw pile, is where you place the card you threw
out from your hand.    However, you may pick up a card from either the draw pile or discard 
pile.



Once the computer deals out the cards, the draw pile, located to the left of the discard pile,
is where the remaining cards in the deck are placed, face down.    The top card in the pile is 
turned over and placed face up in the discard pile.    A player may then select a card from 
either the draw pile or the discard pile.



The act of stating to the other players that you want to stop playing and compare hands, 
since you believe your hand to be one of the highest.    When you select the knock button 
on the player icon, the other players get one more turn, and then the total value of all 
hands is compared.    The player with the lowest score loses the hand.

In order to "knock", a player must have at least a total hand value of 21 points.



Each player is given four gold coins at the start of a game.    The coins represent money, 
and are used to keep track of who is winning and who is losing.    When a player loses a 
hand, they lose a coin.    When all of a player's coins are gone, they have lost the game and 
are eliminated.



The OK button applies and saves the selections you made.



The cancel button closes the window and uses the selection last specified. 



The Help button displays the online Help system.    The topic most relevant to the function 
you are performing will be shown.




